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SMS 12.3 Tutorial 

BOUSS-2D  

 

Objectives 

Learn to use the interface for BOUSS-2D and run the model for a sample application. This example steps 

through the process of setting up and running a simulation using data from the area around Kalaeloa 

Barbers Point Harbor in Hawaii  

 

Prerequisites 

 Overview Tutorial 

 

Requirements 

 Map Module 

 Cartesian Grid Module 

 Scatter Module 

 BOUSS-2D 

 

Time 

 60–90 minutes 

 

  

v. 12.3 
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1 Introduction 

As a phase-resolving nonlinear wave model, BOUSS-2D can be used in the modeling of 

various wave phenomena including shoaling, refraction, diffraction, full/partial reflection 

and transmission, bottom friction, nonlinear wave-wave interactions, wave breaking and 

dissipation, wave runup and overtopping of structures, wave-current interaction, and 

wave-induced currents.  

The data used for this tutorial includes images, bathymetry data, and coastline data for the 

southwest corner of the island of Oahu, Hawaii. 

2 Getting Started 

Open the background data for this project by doing the following: 

1. Select File | Open… to bring up the Open dialog.  

2. Browse to the data files folder for this tutorial and select “topo1.jpg”. 

3. Click Open to import the image and exit the Open dialog. 

The directory also includes a WLD file (“topo1.wld”). This indicates the image has been 

registered with geographic coordinates.  

4. Repeat steps 1–3 to open “topo2.jpg”. 

5. Select File | Open… to bring up the Open dialog again.  

6. Select “bp_bathy_filtered.pts” and click Open to exit the Open dialog and bring 

up the Step 1 of 2 page of the File Import Wizard dialog.  

This file includes depth values obtained from a local survey in the Kalaeloa Barbers Point 

Harbor and the immediate coastal region outside the harbor.  

7. In the File import options section, select Delimited and turn on Space. 

8. Enter “2” for Start import at row and turn off Heading row. 
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9. Click Next to go to the Step 2 of 2 page of the File Import Wizard dialog.  

10. Click Finish to accept the defaults and close the File Import Wizard dialog.  

11. Click Display Options  to bring up the Display Options dialog.  

12. Select “Scatter” from the list on that left. 

13. On the Scatter tab, turn on Points and click OK to close the Display Options 

dialog. 

14. Click Open  to bring up the Open dialog.  

15. Select “bp_coast.cst” and click Open to import the file and exit the Open dialog.  

This file contains the coastline definition for the entire island of Oahu. After importing 

the bathymetric data, the project should appear similar to Figure 1.  

 

      Figure 1      Bathymetry and images for project area 

16. Frame  the project 

The project should appear similar to Figure 2. 

 

      Figure 2      Coastline of Oahu with bathymetric data 
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3 Specifying Model Units 

The images came from TerraServer
1
 and are therefore registered to the Transverse 

Mercator NAD 83 coordinate frame. The bathymetry has been transformed to be relative 

to this coordinate frame. Importing the images will set the project to this coordinate 

frame. However, the vertical units must first be changed to meters.  

To do this: 

1. Select Display | Projection… to bring up the Display Projection dialog. 

2. In the Horizontal section, verify that Global projection is selected and the field 

below that states “UTM, Zone: 4 (162˚West - 156˚W - Northern Hemisphere), 

NAD83, meters”. 

3. In the Vertical section, select “Meters” from the Units drop-down. 

4. Click OK to exit the Display Projection dialog. 

5. Right-click on “  Area Property” and select Projection… to open the Object 

Projection dialog. 

6. Repeat steps 2–3, then click OK close the Object Projection dialog. 

7. Repeat steps 2–3 for “  bp_bathy_filtered”, then click OK close the Object 

Projection dialog. 

8. Frame  the project. 

4 Trimming the Coastline 

There is currently more coastline here than is needed, including many other harbors, land 

features, and islands unrelated to Kalaeloa Barbers Point Harbor. Use the following steps 

to trim the coastline to the area involved: 

1. Zoom  into the area being modeled (where the maps and the scattered point 

data are located). 

2. Switch to the Map Module . 

3. Right-click on the “  Area Property” and select Type | Models | BOUSS-2D | 

BOUSS-2D. 

4. Using the Create Feature Arc  tool, create an arc as shown in Figure 3, 

beginning with P1 and continuing through P3. 

5. Using the Select Feature Arc  tool, select the coastline away from area of 

interest and hit the Delete key to eliminate this arc (the part to the right of P3 and 

above P1).  

6. Click Yes when asked to confirm the deletion. 

                                                      

1
 See http://www.terraserver.com/ for more details. 

http://www.terraserver.com/
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      Figure 3      Arc bisecting area around simulation from island 

7. Frame  the project to show various islands which did not get deleted with the 

main island shoreline arc. 

8. Using the Select Feature Arc  tool, drag a box around the various island arcs 

and Delete them. Repeat until all the island arcs are deleted  

9. Frame  the project when done. 

The project should appear similar to Figure 4. 

 

      Figure 4      Area of interest after extra coastline arcs deleted 

10. Build a polygon to represent the land around Kalaeloa Barbers Point Harbor by 

selecting Feature Objects | Build Polygons. 

11. Using the Select Polygon  tool, select the newly-created land polygon. 

12. Select Feature Objects | Select/Delete Data… to bring up the Select/Delete Data 

dialog (Figure 5). 

13. In the Function Type section, select Delete. 

14. In the Data Domain section, select Inside the polygon(s). 
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15. In the Choose Data to Select section, select Scatter and select “Triangles” from 

the drop-down.  

This will delete triangles inside the polygon.  

16. Turn on “bp_bathy_filtered” under “Scatter Data” in the dataset tree.  

17. Click OK to close the Select/Delete Data dialog.  

The surface now represents the seabed around the region of Kalaeloa Barbers Point 

Harbor. The next step is to create a computational grid for BOUSS-2D. 

 

      Figure 5      Select / Delete Data dialog 

5 Creating the Grid 

The computational domain of BOUSS-2D is a Cartesian grid that can be defined with 

three mouse clicks. To ensure consistency, create the grid by following these steps: 

1. Zoom  into the harbor area as shown in Figure 6. 
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      Figure 6      Zoomed view of harbor area 

2. Select “  Area Property” to make it active. 

3. Using the Create 2-D Grid Frame  tool, click a grid approximately as shown 

in Figure 7. The grid does not have to be exactly the same since it will be 

modified in the Map → 2D Grid dialog. 

 

      Figure 7      Grid frame 

4. Right-click “  Area Property” and select Convert | Map → 2D Grid to bring up 

the Map → 2D Grid dialog (Figure 8).  

5. In the Origin, Orientation and Dimensions section, enter “590100.0” as the 

Origin X. 

6. Enter “2356750.0” as the Origin Y. 

7. Enter “23.0” as the Angle. 
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8. Enter “2500.0” as the I Size. 

9. Enter “2000.0” as the J Size. 

10. In the Elevation options section, select “Scatter Set” from the Source drop-down 

and click Select… to bring up the Interpolation dialog. 

11. In the Interpolation Options section, enter “1.0” as the Single Value.  

This assures that the land will be treated as land. This step would not be required if 

survey data included points on the shore with positive elevations. 

 

      Figure 8      Parameters to create the grid 

12. Click OK to close the Interpolation dialog.  

For the next part, keep in mind that an appropriate cell size depends on the wavelength of 

the waves being modeled. 

13. Click Grid Helps… to open the BOUSS-2D Map → 2D Grid Helps dialog.  

14. Turn on T (wave period) and enter “15.0”. 

15. Click OK to close the BOUSS-2D Map → 2D Grid Helps dialog.  

Notice that the recommended cell size is about 11.7 meters. Smaller cells increase the 

definition of the model, but also increase computation time. For the purposes of this 

tutorial, a smaller cell size will be used. 

16. Enter “10.0” as the Cell size in both the I Cell Options and J Cell Options 

sections. 

17. Click OK to close the Map → 2D Grid dialog and create the grid. 
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18. Right-click on the newly created “  Area Property Grid” and select Rename.  

19. Enter “10m Grid” and press Enter to set the new name.  

It is a good habit to change the name of grids once they are created so that basic 

information about them can be recognized through the name. It is now easy to see that the 

grid has a cell size of 10m in I and J directions. 

20. Turn off “  Scatter Data” and “  Map Data” in the Project Explorer. 

21. Select Display | Display Options… to open the Display Options dialog.  

22. Select “Cartesian Grid” from the list on the left. 

23. On the Cartesian Grid tab, turn off Cells and turn on Contours. 

24. On the Contours tab, in the Contour method section, select “Color Fill” from the 

first drop-down. 

25. Enter “25” as the Transparency. 

26. Click OK to close the Display Options dialog. 

The display should appear similar to Figure 9. 

 

Figure 9      Resulting grid contours 

6 Generate a Wave Maker 

Wave makers are created through map coverages. To create a wave maker, follow these 

steps: 

1. Right-click on the “  Map Data” item in the Project Explorer and select New 

Coverage to open the New Coverage dialog. 

2. In the Coverage type section, select Models | BOUSS-2D | Wave Maker. 

3. Enter “Wave Maker” as the Coverage Name.  

4. Click OK to close the New Coverage dialog. 
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5. Select “  Wave Maker” to make it active. 

6. Using the Create Feature Point  tool, create a point in the new coverage as 

indicated in Figure 10.  

 

      Figure 10      Wave Maker map coverage with feature point 

7 Defining the Wave Maker 

The BOUSS-2D wave maker must be positioned at a point in the grid. In SMS, create the 

wave maker on a point at a desired location.  

To define a wave maker, follow these steps: 

1. Using the Select Feature Point  tool, select the newly created point. 

2. Right-click and select Node Attributes... to bring up the BOUSS-2D Wave 

Generator Properties dialog. 

3. In the Wave Simulation Parameters section, select “Irregular Unidirectional” 

from the Type drop-down.  

4. Enter “750.0” as the Series duration and press Tab. 

5. Click OK to acknowledge the message about changing the period for all wave 

makers. 

6. In the Spectral Parameters section, select “JONSWAP Spectrum” from the Type 

drop-down. 

7. Select “Specify hs and Tp” from the Option drop-down.  

This allows the significant wave height and peak period values (Hs & Tp) to be set as 

follows:  

8. In the spreadsheet, enter “3.0” as Sig. Wave Height (m).  

9. Enter “15.0” as Peak Wave Period (s). 

10. In the Directional Parameters, select “Meteorologic” from the Projection drop-

down. 

11. Enter “245.0” as the Wave angle. 

12. Leave all other parameters at their defaults. 

13. Click OK to close the BOUSS-2D Wave Generator Properties dialog. 
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14. If asked, click the Yes button to force a constant elevation.  

As SMS generates the wave maker, this indicates that the offshore edge of the grid is not 

of constant depth. The wave maker should appear similar to Figure 11. 

 

Figure 11      Arrow indicates direction of waves from the wave maker 

8 Creating Roughness Coefficients  

To create the roughness coefficients, do the following: 

1. Right-click on “  Map Data” and select New Coverage to open the New 

Coverage dialog. 

2. In the Coverage Type section, select Models | BOUSS-2D | Roughness. 

3. Enter “Roughness” as the Coverage Name. 

4. Click OK to close the New Coverage dialog. 

5. Select the new “  Roughness” coverage to make it active.  

6. Using the Create Feature Arc  tool, click out five enclosed arcs as shown in      

Figure 12.  

7. Select Feature Object | Build Polygons. 

8. Using the Select Feature Polygon  tool, double-click on polygon 1 (as 

indicated in Figure 12) to bring up the Roughness dialog.  

9. Enter “60.0” as the Chézy coefficient and click OK to close the Roughness 

dialog. 

10. Repeat step 8–9  for polygon 2, entering “30.0” as the Chezy coefficient. 

11. Repeat step 8–9  for polygon 3, entering “25.0” as the Chezy coefficient. 

12. Repeat step 8–9  for polygon 4, entering “40.0” as the Chezy coefficient. 

13. Repeat step 8–9  for polygon 5, entering “30.0” as the Chezy coefficient. 

14. Right-click “  Roughness” and select Convert | Map → Active Grid to bring 

up the Map → Active Grid dialog.  

15. Enter “30.0” as the Default Value. 

16. Enter “Roughness” as the Dataset Name.  

17. Click OK to close the Map → Active Grid dialog. 
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      Figure 12      Polygons 

9 Creating a BOUSS-2D Simulation 

The next step in preparing a simulation is to specify model input parameters by first 

creating the BOUSS-2D simulation: 

1. Right-click on an empty space in the Project Explorer and select New Simulation 

| BOUSS-2D.  

2. Right-click on the newly created “  Simulation” item and select Rename. 

3. Enter “BarbersPoint” and press Enter to set the new name.  

4. Drag both “  10m Grid” and “  Wave Maker” under “  BarbersPoint”. 

5. Right-click on “  BarbersPoint” and select Model Control… to bring up the 

BOUSS-2D Model Control dialog. 

6. Enter “Barbers Point Sample Run” as the Project title.  

7. In the Time Control section, enter “1500.0” as the Duration.  

This value should be greater than the computed default (the number in the Recommended 

column) in that field.  

8. Enter “0.25” as the Time step.  

The default time step is set to correspond with a Courant number of “0.6”. Reducing the 

time step increases stability. The time step should not be increased. 

9. In the Parameters section, turn on Enable wave runup and enter “0.018” as the 

Min. flooding depth. 

10. In the Output Options section, turn on all options under Time independent. 

11. Under Animation Output, turn on Output WSE, Output Velocity and Override 

Defaults.  
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For this case, first generate a series of solutions corresponding to the last five wave cycles 

(75 seconds) by changing the settings as follows: 

12. Enter “1425.0” for Begin output. 

13. Enter “1500.0” for End output. 

14. Enter “1.0” as the Step.  

The defaults for the above three parameters save the water level and velocity at even 

increments for the entire simulation. This generally results in either a huge output file or a 

discontinuous set of solution snap shots. An approximate size for the solution file is 

displayed to the left under Required memory. 

15. Click OK to close the BOUSS-2D Model Control dialog. 

10 Defining Damping Layers 

If no damping is applied to the model, wave energy that is not dissipated along gradually 

sloping beaches will be bounced back into the domain. To calibrate to real world cases, 

or to prevent wave reflections from spreading back to the wave maker, it may be 

necessary to employ damping layers.  

BOUSS-2D uses a dataset with a damping value at each cell to compute the damping of 

waves. A damping value of 0.0 indicates no damping and is the default. As the damping 

value increases (up to 1.0), and the number of damping cells adjacent to each other 

increases, the energy that is reflected back from the edge of the computation domain 

decreases. 

Damping layers are created in coverages by doing the following: 

1. Turn on “  Area Property” and select “  Elevation” under “  10m Grid” in 

the Project Explorer. 

2. Right-click on “  BarbersPoint” and select Generate Arcs Along Land 

Boundary… to bring up the Generate Arcs dialog. 

3. Select “Grid” from the Generate from drop-down. 

4. Click (none selected) next to Item to bring up the Select Tree Item dialog. 

5. Select “10m Grid” and click OK to close the Select Tree Item dialog. 

6. In the Destination coverage section, select Create New Coverage  

7. Select “Damping” from the Type drop-down. 

8. Enter”0” as the Elevation. 

9. Click OK to close the Generate Arcs dialog.  

This builds a new coverage called “Damping” that contains an arc along the boundary 

(Figure 13). 

10. Select “  Damping” to make it active. 

11. Using the Select Feature Arc  tool, double-click on the arc to bring up the 

Damping Properties dialog. 
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12. Enter “20.0” as the Width (the combined width of two cells). 

13. Enter “0.2” as the Coefficient.  

14. Click OK to close the Damping Properties dialog. 

The width value for the damping depends on several factors including wave length and 

grid resolution. This small damping coefficient will reduce wave reflection inside the 

harbor. 

15. Drag “  Damping” under “  BarbersPoint” if it is not already linked to the 

simulation. 

16. Click anywhere outside of the damping boundary arc to deselect it. 

 

      Figure 13      Boundary arc along the shoreline 

11 Saving and Running the Simulation 

The final step before running a simulation is to save the files for BOUSS-2D by doing the 

following: 

1. Select File | Save As… to bring up the Save As dialog. 

2. Enter “BarbersPoint_damping.sms” as the File name. 

3. Click Save to save the project under the new name and exit the Save As dialog.  

This saves all the data files for execution. 

4. Right-click on “  BarbersPoint” and select Export BOUSS-2D.  

5. Right-click on “  BarbersPoint” and select Run BOUSS-2D to bring up the 

BOUSS-2D model wrapper dialog. 

6. A Model Checker dialog may appear, warning that the selected run time is longer 

than the recommended time. Click Run Model to exit the Model Checker dialog. 

If using a normal installation of SMS, the model should launch immediately. If SMS 

cannot find the BOUSS-2D executable, a message will be displayed asking to locate the 

desired executable. 

This simulation may take several minutes to run with a 0.25 sec time step, depending on 

the speed of the computer being used. The model run time increases or decreases linearly 

based on the number of computational cells. 
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7. After the model run is complete, turn on Load solution and click Exit to close the 

BOUSS-2D model wrapper dialog. 

8. If the Dataset Time Information dialog appears, choose to use seconds for all 

datasets and click OK to exit the Dataset Time Information dialog. 

12 Visualize Simulation Results 

The model will create nine solution datasets that include spatially varying results at the 

grid nodes. Seven of these are scalar datasets:  

 Wave breaking animation (Breaking Animation) 

 Maximum Runup Height (Max. Runup Height) 

 Mean wave level (Mean Water Level) 

 Mean wave directions (Mean Wave Direction) 

 Significant wave height (Sig. Wave Height) 

 Velocity magnitude animation (Velocity Animation Mag)  

 Water surface elevation animation (WSE Animation)  

The other two are vector datasets:  

 Mean Velocity 

 Velocity Animation  

BOUSS-2D can save these results in two ways: in multiple separate files, or in a single 

binary file (HDF5 format). In this case, BOUSS-2D created the file 

“BarbersPoint_sol.h5” at the end of the run. SMS creates a folder in the Project Explorer 

containing all of the datasets (in this case, “barberspoint”). 

To display a functional surface of the water surface: 

1. Select Display | Display Options… to open the Display Options dialog. 

2. Select Cartesian Grid from the list on the left. 

3. On the Cartesian Grid tab, turn off Cells and turn on Contours and Functional 

surface. 

4. Click Options… right under the Functional surface option to bring up the 

Functional Surface Options dialog. 

5. In the Dataset section, select User defined dataset to bring up the Select Dataset 

dialog 

6. Select “WSE Animation” from the list of datasets and click Select to close the 

Select Dataset dialog. 

7. In the Z Offset section, select “Display surface above geometry” from the drop-

down. 

8. In the Z Magnification section, turn on Override global value and enter “50.0” as 

the Magnification value. 
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9. In the Display Attributes section, select Use solid color and click the larger Color 

button to bring up the Color dialog. 

10. Select cyan on the top row under Basic colors (fifth box from the left) and click 

OK to close the Color dialog. 

11. Click OK to close the Functional Surface Options dialog. 

12. On the Contours tab, in the Contour method section, select “Color Fill” from the  

first drop-down. 

13. Select General from the list on the left. 

14. On the General tab, turn off “Auto z-mag” in the Drawing Options section. 

15. Enter “20.0” as the Z magnification.  

This amplifies the variation in the z-direction due to the very small wave heights 

compared to the size of the domain. 

16. On the Lighting tab, turn on Enable lights. 

17. Turn on Smooth edges in the Surface attributes for all lights section 

18. Click and drag the sphere until the dot is in the upper right quarter of the sphere, 

about a third of the way from the edge to the center of the sphere (see Figure 14). 

This will give good lighting contrast for the 3D view. 

 

      Figure 14      Lighting tab showing lighting direction 

19. On the View tab, select View angle and enter “40.0” as the Bearing and “25.0” as 

the Dip.  

20. Click OK to close the Display Options dialog. 

21. Select the “  Elevation” dataset in the Project Explorer to show the contour on 

the bottom of the ocean.  

The system may take a several minutes to update the display, depending on the 

capabilities of the computer. Figure 15 shows this functional surface of the water surface 

over the bathymetric surface. The contour colors may vary. In this case, the contours are 

set to display a hue ramp with blue at the maximum end and the depth function active. 
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      Figure 15 Water level functional surface over the bathymetry (magnified 20x) 

All of the standard visualization methods described in the Data Visualization tutorial also 

work for the solutions generated by BOUSS-2D. Experiment with other options to view 

the solution. 

13 Adding Probes 

Probes can be added to the already existing Cartesian Grid in order to visualize the water 

surface elevation, pressure and velocities time series at that specific point on the grid. 

This can be useful to see the differences in water surface elevation for different parts of 

the grid. 

To do this: 

1. Select “  10m Grid” in the Project Explorer. 

2. Using the Select Grid Cell  tool, hold down the Shift key and select three cells 

in roughly the same position as those shown in Figure 16. 

3. Right-click “  BarbersPoint” and select Probe Manager… to bring up the 

BOUSS-2D Probe Manager dialog. 

4. Click Create Probes at Selected Cells to create a probe at each of the selected 

cells. 

5. Turn on WSE (Water Surface Elevation) for all three probes. 

6. Turn on Pressure for all three probes.  

7. Click Options… to the right of the Pressure column for “Probe #1” to bring up 

the Pressure Probe Options dialog.  
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      Figure 16      Probe positions 

8. Enter “1.0” in the Elevation above sea bed column and press Enter to create a 

new blank line. 

9. Enter “5.0” on the new blank line and press Enter. 

10. Click OK to close the Pressure Probe Options dialog. 

11. Repeat steps 7–10 for “Probe #2” and “Probe #3”. 

12. Turn on Velocity for the three probes.  

13. Click Options… to the right of the Velocity column for “Probe #1” to open the 

UV Probe Options dialog. 

14. Enter “2.0” in the Elevation above sea bed column and press Enter to create a 

new blank line. 

15. Enter “6.0” in the Elevation above sea bed column and press Enter. 

16. Click OK to close the UV Probe Options dialog.  

This allows viewing of the velocity changes at 2.0 m and 6.0 m above sea level 

throughout the simulation run.  

17. Repeat steps 13–16 for “Probe #2” and “Probe #3”. 

18. Click OK to exit the BOUSS-2D Probe Manager dialog. 

13.1 Changing Display 

The probes might not be easily visible at this point if the scatter set and Contours are 

turned on.  

1. Select Display | Display Options to bring up the Display Options dialog. 
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2. Select Cartesian Grid from the list on the left. 

3. On the Cartesian Grid tab, turn on Cells and turn off Ocean cell. 

4. Turn on Probe without time series data.  

5. Turn on Probe with time series data.  

6. On the Contours tab, make sure “Color Fill” is selected from the first drop-down 

in the Contour method section. 

7. Enter “75” as the Transparency. 

8. Click OK to exit Display Options dialog.  

Once BOUSS-2D is run and the solutions imported, the probes will have time series data 

and be seen as filled squares. 

13.2 Saving New Project and Simulation Run 

Now that the new probes have been created, it is time to run BOUSS-2D again. First, 

save a new SMS project by doing the following 

1. Select File | Save As… to open the Save As dialog. 

2. Enter “BarbersPoint_probes.sms” as the File name. 

3. Click Save to save the project under the new name and close the Save As dialog. 

4. Right-click “  BarbersPoint” and select Save Project, Export and Run 

BOUSS-2D to open the BOUSS-2D model wrapper dialog. 

Depending on the speed of the computer being used, the simulation may take several 

minutes to finish.  

5. Once BOUSS-2D is finished, turn on Load Solution Files and click Exit to close 

the BOUSS-2 model wrapper dialog. 

13.3 Importing the Probe Files and Viewing Solutions 

The solution files that were opened previously will not open the Probe files. Therefore 

these files must be opened manually. 

1. Select File | Open… to bring up the Open dialog. 

2. Browse to the data files\BOUSS-2D\BarbersPoint\ folder and select to following 

files: 

 “barberspoint_ts_eta.ts1” 

 “barberspoint_ts_pressure.ts1” 

 “barberspoint_ts_u.ts1” 

 “barberspoint_ts_v.ts1” 

3. Click Open to import the files and exit the Open dialog. 

4. Once the files are loaded, select the three probes using the Select Grid Cell  

tool and carefully select the appropriate cells. 
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5. Right-click on the display and select Eta Time Series Plot from the menu to 

bring up a plot window. Since all three probes are selected, three plots can be 

seen in the Time Series dialog. The plots should look like Figure 17. 

6. With the probes still selected, right-click on the display again and select Zero-

crossing Analysis | ETA Time Series. This will bring up the Zero-crossing 

Analysis dialog. 

The zero-crossing analysis will contain information for each probe.  

 HAV (m) – Average wavelength for the full time series. 

 H13 (m) – Average of the highest 3 % of water surface elevation. 

 H110 (m) – Average of the highest 10 % of water surface elevation. 

 HMAX (m) – Highest water surface elevation. 

 TAV (s) – Average time periods for the full time series. 

 T13 (s) – Average of the highest 3 % of time periods. 

 T110 (s) – Average of the highest 10 % of time periods. 

 

      Figure 17      Water surface elevation probe plots 

14 Conclusion 

This concludes the “BOUSS-2D” overview tutorial. Feel free to continue experimenting 

with the SMS interface, or exit the program. 


